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1

CHAPTER 1

Installation

This chapter contains the following tasks for installing the RAID Manager software
with the Solaris™ operating system:

■ Software Installation Overview — page 1

■ Checking the Hardware and Software — page 2

■ Installing the Software — page 4

■ De-installing the RAID Manager Software — page 14

■ Configuring the Solaris Environment to Support RAID Manager — page 15

■ SNMP Notification — page 20

■ Software Limitations — page 24

Software Installation Overview
■ Ensure all hardware, and the minimum software components required, are

properly installed as described in “Checking the Hardware and Software” on
page 2.

■ Install the RAID Manager Software as described in “Installing the Software” on
page 4.

■ Install patches to support RAID Manager.
■ Configure your operating system to support RAID Manager as described in

“Configuring the Solaris Environment to Support RAID Manager” on page 15.
■ Reboot your host system.
■ Verify the installation as described on page 13.
■ Launch the RAID Manager software as described in Chapter 2, “Initial Startup.”
■ Refer to the RAID Manager User’s Guide for information about using the RAID

Manager software.
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Checking the Hardware and Software
Before installing the RAID Manager software, make sure you have the following
components installed:

■ The Solaris 2.5.1 or 2.6 operating system.

■ You can use the uname -a  command to obtain version information. The version is
specified as either 5.5.1 (for Solaris 2.5.1) or 5.6 (for Solaris 2.6).

■ At least an 800 x 600 resolution graphics card and mouse

■ SCSI-2 FAST and WIDE (DWIS), or Ultra SCSI (UDWIS) host adapter(s)

■ RAID SCSI array controllers with downloaded firmware version 2.4.4 and boot
firmware of 2.4.4 or later

■ A host machine with one of the following configurations:

■ Single-Host Configuration — one host machine is connected by two SCSI Buses
to each controller in a RAID Module.

■ Multi-Host Configuration — two host machines are each connected by two SCSI
Buses to both of the controllers in a RAID Module.

■ Independent Controller Configuration — two host machines are connected to a
dual-controller RAID Module. One host machine is connected by a SCSI Bus to
one controller, and a second host machine is connected by another SCSI Bus to
the other controller.

Note – You can install RAID Manager with firmware versions before 2.4.4; however,
you must immediately upgrade the firmware to version 2.4.4 or later after you have
completed the installation. (See “Upgrading Controller Firmware” on page 29 for
instructions on how to upgrade firmware.)

Note – It is assumed the host system does not have networked capability. If the host
system is networked, see “SNMP Notification” to set up and enable the SNMP
option.
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1. Use the following checklist to make sure that the RAID Module(s) have been
connected correctly to your host system.

If necessary, refer to the RAID Manager User’s Guide.

Caution – Each controller in a RAID Module must have its own SCSI connection
(that is, SCSI bus cable and host adapter) into the host system. This is the only
configuration supported. For the greatest level of I/O path protection, each HBA
should be on different I/O (system) boards.

2. Continue with “Installing the Software.”

Completed Task Notes

Cable connections are correct
and secure.

Without the system running (at the ok
prompt), type probe-scsi-all  to scan
the SCSI buses and list all hardware paths
and the devices attached to your system.
This process list the targets (SCSI IDs) of
the devices connected and recognized by
your host adapter. There should be a target
(SCSI ID) listed for each RAID controller in
your RAID Modules. If a target is not
listed, check the cable connections.

Termination is correct and
secure.

SCSI IDs are set properly. Each controller in each RAID Module must
have a unique SCSI ID (that is, no two
controllers on the same SCSI bus can have
the same SCSI ID).
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Installing the Software

Caution – Be sure all hardware is connected to your host system before installing the
software. Failure to do so could cause your system to panic.

▼ Mounting the CD-ROM

Note – Depending on how your workstation is configured, your CD-ROM drive
may be mounted automatically. If the CD-ROM drive is not mounted, you must
mount it before you can install the software.

1. Is the CD-ROM mounted?

Yes? Continue with Step 4.

No? Continue with Step 2.

2. If no mount point directory exists, create one.

3. Mount the CD-ROM drive by typing:

Where cXtXdXsX  is the device node of the CD-ROM (for example, c0t6d0s0 ) and
/cdrom  is the mount point.

4. Load the disc label-side facing up into the CD-ROM drive.

5. Continue with “RAID Manager Installation Options.”

RAID Manager Installation Options
There are two methods (swmtool  and pkgadd ) that can be used to install the RAID
Manager software. swmtool  provides a graphical user interface (GUI) that simplifies
the task of installing the RAID Manager software package clusters. pkgadd  is the
standard command line interface installation process. Refer to TABLE 1-1 for package
descriptions.

# mount -F hsfs -o ro /dev/dsk/ cXtXdXsX /cdrom
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After mounting the CD-ROM drive, you can use one of the following methods to
install the software for use with the Solaris operating system.

■ swmtool

swmtool , the Software Manager, is the recommended method to use when installing
software package clusters from the software CD. To use swmtool , you must have
the X Window system installed on your system and running OpenWindows™. For
instructions on using swmtool , refer to “To Install RAID Manager Using swmtool”
on page 6.

Note – swmtool  is the installation method described throughout this chapter
(unless otherwise noted). pkgadd  instructions are also provided if you prefer this
method of installation.

■ pkgadd

pkgadd  is another method used to install software package clusters from the
software CD. pkgadd  differs from swmtool  in that you do not need to run
OpenWindows; you can invoke the pkgadd  command at the operating system
prompt. For instructions on using pkgadd , refer to “To Install RAID Manager Using
pkgadd” on page 8.

TABLE 1-1 Package Descriptions

Cluster Name Description

SUNWosafw Open Storage Array (firmware)

SUNWosar Open Storage Array (root)

SUNWosau Open Storage Array (usr)

SUNWosamn Open Storage Array (man pages)

SUNWosaab AnswerBook (RAID Manager User’s Guide)

SUNWosaib AnswerBook (RAID Manager Installation and Support
Guide)

SUNWosahb AnswerBook (RSM Array 2000 hardware
documentation)
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▼ To Install RAID Manager Using swmtool

Caution – This installation procedure requires you to reboot your system. Therefore,
make sure that other users are not on the system when installing this software.

Note – Make sure the installation media device you are using is attached when you
boot the system.

1. Start the OpenWindows environment.

2. Load the RAID Manager CD into your CD-ROM drive, label-side facing up.

If there is another CD in the drive, remove it by typing eject  in a shell window.

3. Open File Manager.

4. Open a command window and (if you are not already superuser ) become
superuser  using the su  command and superuser  password.

5. Start Software Manager by typing:

Admintool:Software  is displayed.

6. Select Edit ... Add.

The Set Source Media window is displayed.

7. Select Mounted Directory if you are running Volume Management or Local CD-
ROM as your media type.

8. Type the path to the source media in the Directory Name:

The Software Manager window is displayed with the RAID Manager clusters to be
installed.

9. Click on the RAID Manager 6.1 clusters (Software  and AnswerBooks ) to be
installed.

Click on Customize if you need to change the RAID Manager packages.

# /usr/sbin/swmtool

/cdrom/raid_manager_6_1/Product/
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10. Click the Add button.

The Software Manager: Command Input/Output window is displayed with pre-
installation information followed by this prompt:

11. Respond with <y>  (yes).

Installation messages are displayed in the Software Manager: Command Input/
Output window.

It may take one to two minutes before you notice certain tasks occurring (see
TABLE 1-2).

The following message is displayed after the installation process has been
completed:

where SUNWxxxx is the specific package name.

12. Quit Software Manager.

Caution – Install the software patches for your Solaris environment if you have not
done so already. Failure to do so may cause your system to boot improperly. Refer to
the patch information in the Sun RSM Array 2000 Product Release Notes.

13. Shut down the system by typing:

See the man page, shutdown (1M), for more information if needed. Using the
shutdown  command is more efficient than using the halt  command.

Caution – Make sure you use the boot -r  option for the reboot required in Step 14
and in future reboots following any changes in RAID configuration.

Do you want to continue with this installation?

Installation of SUNWxxxx was successful.

shutdown -y -i0 -g0
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14. Reboot the system by typing:

Several additional tasks are performed as the system reboots. You may notice some
of these shown in TABLE 1-3.

15. When the message The system is ready  displays, do you see the NVSRAM
settings are correct  message?

If Yes?

Continue with “To Verify the Installation” on page 13.

If No?

If the NVSRAM message says that settings were changed, do the following:

■ Reboot the system by typing:

■ After the system reboots, continue with “To Verify the Installation” on page 13.

▼ To Install RAID Manager Using pkgadd

Note – Before beginning this procedure, make sure you install patches that may be
required for your Solaris environment. Refer to the Sun RSM Array 2000 Product
Release Notes for patch numbers.

Caution – This installation procedure requires you to reboot your system.
Therefore, make sure that other users are not on the system when installing this
software.

Note – Make sure the installation media device you are using is attached when you
boot the system.

1. Load the RAID Manager CD into your CD-ROM drive, label-side facing up.

If there is another CD in the drive, remove it by typing eject  in a shell tool
window.

boot -r

reboot -- -r
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2. Become superuser  using the su  command.

3. Type:

The argument to the -d  option must be a full path name to a device or directory. If
you do not specify the device on which the package resides, pkgadd  checks the
default spool directory (/var/spool/pkg ). If the package is not there, the
installation fails.

To install RAID Manager, choose the packages in the following order:

■ SUNWosafw
■ SUNWosar
■ SUNWosau
■ SUNWosamn
■ SUNWosaab
■ SUNWosaib
■ SUNWosahb

During pkgadd  installation, information is displayed, followed by this prompt:

# /usr/sbin/pkgadd -d /cdrom/raid_manager_6_1/Product

Do you want to continue with this installation?
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4. Respond with <y>  (yes).

It may take one to two minutes before you notice certain tasks occurring (see
TABLE 1-2).

5. When you finish reviewing the readme  file, quit pkgadd .

You will see a message that the system must now be rebooted using
shutdown -y -i0 -g0 .

TABLE 1-2 Tasks Performed During Installation

What You Will See
Automatic Task
Occurring Why Is The Task Being Done?

Installing RAID Manager
as <rm6> and a listing of
directories and files being
copied.

Files being copied to
the host system.

All of the files are being
copied to the appropriate
directories.

Installing man pages Reference man pages
being copied to the
host system.

man pages associated with
RAID Manager are being
copied to the appropriate
directory.

kernel/drv/sd.conf
already exists. OK to
modify?

sd.conf  file being
replaced.

This file is used to specify the
logical unit (LUN) support
for the operating system, but
initially has only LUN 0
defined for each SCSI ID.
Therefore, this file is edited
to add multiple LUN support
(0-7) for each controller in
each RAID Module
connected to the host system.

Adding RAID Manager
changes to
/etc/syslog.conf

syslog.conf  file
being edited.

RAID Manager logs certain
failure messages from the
arraymon  daemon and the
graphical user interface
(GUI) applications to the
syslogd  daemon. This file is
edited to ensure that Solaris
consistently logs these
messages to this file.

RAID Manager readme file
/etc/raid/README

The readme file is
displayed.

The readme file provides
important information about
the software.
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Caution – Install the software patches for your Solaris environment if you have not
done so already. Failure to do so may cause your system to boot improperly. Refer to
the patch information in the Sun RSM Array 2000 Product Release Notes.

6. Shut down the system by typing:

See the man page, shutdown (1M), for more information if needed. Using this
shutdown command is more efficient than using the halt  command.

Caution – Make sure you use the boot -r  option for the reboot required in Step 7
and in future reboots following any changes in RAID configuration.

7. Reboot the system by typing boot -r .

Several additional tasks are performed as the system reboots. You may notice some
of these shown in TABLE 1-3.

When the message The system is ready  displays, do you see the NVSRAM
settings are correct  message?

If Yes?

Continue with “To Verify the Installation” on page 13.

If No?

If the NVSRAM message says that settings were changed, do the following:

a. Reboot the system by typing:

b. After the system reboots, continue with “To Verify the Installation” on page 13.

shutdown -y -i0 -g0

reboot -- -r
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TABLE 1-3 Tasks Performed During System Reboot

What You Will See Automatic Task Occurring Why Is The Task Being Done?

Setting up RAID Manager device
access
Re-generating rdexus.conf file
Re-generating rdriver.conf file

The software is setting up
the correct device nodes
for Redundant Disk
Array Controller (RDAC)
support.

To ensure software device
access.

RDAC Driver loaded
RDAC Daemons Initiated

The Redundant Disk
Array Controller (RDAC)
driver is loaded and
RDAC daemons are
started.

The RDAC Driver and
daemons provide fail-over
support for the I/O data
paths.

Note: For a description of
RDAC and the protection it
provides, refer to the rdac
man page.

Example if NO changes were made:
The NVRAM settings of
controller cXtXdX (1TXXXXXXX) are
correct.
nvutil command succeeded.

Example if changes were made:
The NVRAM value of Unconfigured
LUNs bit field of controller
cXtXdX (1TXXXXXXX) at offset 0x11
is invalid, the value is 0x20
(the valid value should be 0x0).
The incorrect NVRAM settings of
controller cXtXdX (1TXXXXXXX)
have been fixed.
Reboot the system for the new
settings to take effect.
nvutil command succeeded.

Note: If you have trouble getting the
software to recognize the RAID Modules,
review “NVRAM Settings” on page 59.

NVRAM settings on the
controller(s) in the RAID
Module being checked
and, if necessary,
corrected by the nvutil
program.

Certain configuration
settings must be set so that
the software can
communicate correctly with
the controllers in the RAID
Module.

Array monitor initiated The monitor daemon
(arraymon ) is started.

The array monitor daemon
(arraymon ) automatically
checks the RAID Module(s)
for any problems/events and
provides appropriate
notification.
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▼ To Upgrade RAID Manager from a Previous
Version

1. First save your rmparams  file as rmparams.ori if you want a record of any
customized settings you have made.

2. Save a copy of your current configuration information (using File ➔ Save Module
Profile, All information types).

3. Make a list of your current RAID Modules and their name or number under the
previous version of software.

The RAID Module numbers or names will change; thus, any labels that you have
placed on your RAID Modules will not correspond to the list of modules in the new
version of this software. In this new version, the module name is derived from the
name of the host machine where the storage management software is installed. The
old version labeled the modules RAID Module XX. The new version labels them
<hostname>_XXX. Therefore, for example, a module connected to a host machine
running this software named qualab133  would be called qualab133_XXX .

4. Make sure the previous version of the software is not currently open or running.

Use pkgrm (see “De-installing the RAID Manager Software”) and follow the
instructions on the screen to remove any previous versions of RAID Manager to
prevent any conflicts. If you have previously been using your RAID Module,
unmount any file systems and stop any other I/O to the module.

5. Follow the steps in “To Install RAID Manager Using pkgadd.”

To Verify the Installation
1. At the command line, type:

A list showing statistics (version information, installation date, file information, etc.)
about the software should display. The status field reads “completely installed” if
the installation was successful.

RDAC Resolution Daemon locked in
memory...

RDAC is set up to resolve
errors.

If errors occur, RDAC can
resolve them.

pkginfo -l package_name

TABLE 1-3 Tasks Performed During System Reboot (Continued)

What You Will See Automatic Task Occurring Why Is The Task Being Done?
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2. At the command line type:

A confirmation line should show the array monitor (arraymon ) as a working
process.

3. At the command line type:

A confirmation line should show the rdac  resolution/restart daemons as two
working processes.

■ If the previous steps are unsuccessful, try the following:

a. Shut down the system by typing: shutdown -y -i0 -g0

b. Reboot the system by typing: boot -r

c. Repeat Steps 1-3.

■ If you still have problems, reinstall RAID Manager.

De-installing the RAID Manager
Software
If you need to de-install RAID Manager (for example, to reinstall the software if
there was some problem during the installation procedure), use the pkgrm  command
and remove the packages in the following order:

■ # pkgrm SUNWosafw
■ # pkgrm SUNWosau
■ # pkgrm SUNWosar
■ # pkgrm SUNWosamn
■ # pkgrm SUNWosaab
■ # pkgrm SUNWosaib
■ # pkgrm SUNWosahb

Note – If you are de-installing a RAID Manager version prior to 6.1, the
SUNWosafw, SUNWosaib, and SUNWosahb packages do not exist.

ps -ef | grep arraymon

ps -ef | grep rdaemon
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Note – The rmlog.log  file remains in the /var/osa  directory after using pkgrm  to
de-install the software. Although keeping this file should not cause any problems,
you may want to manually delete it.

Configuring the Solaris Environment to
Support RAID Manager
TABLE 1-4 summarizes the changes you need to make to fully support RAID Manager
with the Solaris operating environment.

Patches Required to Support Solaris Operating
Systems
There are patches available to ensure optimum performance of the RAID Manager
software with the Solaris operating system.

Individual patches can be identified by their respective patch ID number. For
information on installing specific patches, refer to the Sun RSM Array 2000 Product
Release Notes.

TABLE 1-4 Required Changes for Solaris Operating Systems

Task To Perform Purpose For More Details, See

Install patches to
support RAID
Manager.

To ensure optimum performance of
RAID Manager with the Solaris
operating systems

“Patches Required to Support Solaris
Operating Systems” on page 15

Edit the rmparams
file.

To increase LUN support per host
adapter and/or enable SNMP
notification

“To Edit the rmparams File” on page 17

Edit the rmscript
file.

To set up scriptable event
notifications (such as third-party
vendor’s paging, Fax, etc.)

“Setting Up Other Scriptable Notification
Options” on page 19

Set the SNMP
notification.

To enable or disable this remote
notification option

“SNMP Notification” on page 20



16 RAID Manager 6.1 Installation and Support Guide for Solaris • October 1997

1. Determine the Solaris version you have by typing:

uname -a

The version is specified as either 5.5.1 (for Solaris 2.5.1) or 5.6 (for Solaris 2.6).

2. Install the correct patch (for your version of Solaris) on your host system.

Note – If you are using Solaris 2.5.1, you need to install the 2.5 /kernel/drv/isp
driver. Using the 2.5.1 driver causes applications to hang.

Increasing Multiple Logical Unit Support in
Solaris 2.6

Note – Solaris 2.6 supports 32 LUNs via a supplemental patch. Refer to the Sun
RSM Array 2000 Product Release Notes for the appropriate patch ID.

There are two separate limits on the number of logical units you can have:

■ Solaris normally limits the maximum number of logical units (LUNs) per RAID
Module to eight (8) (whether the module has a single controller or redundant
controllers). Therefore, if you have a RAID Module with two active controllers,
the total number of LUNs between them cannot be more than eight. (Set the
correct limit for your operating system with the
System_MaxLunsPerController  parameter in the rmparams  file.)

■ The host adapter also has a maximum number of LUNs it can support. (Set the
correct limit for your host adapter with the System_MaxLunsPerHostAdapter
parameter in the rmparams  file. However, making this change alone does not
affect the operating system’s limit of LUNs per RAID Module.) For example, if
you have four RAID Modules and an eight LUN-per-module limit, your host
adapter needs to be able to support the total number of LUNs (32 in this
example).

Several changes are necessary to support multiple LUNs on your host adapter.
Follow the steps in “To Edit the rmparams File” on page 17.
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▼ To Edit the rmparams  File
The /etc/raid/rmparams  file is used to store several configurable options
available through RAID Manager. TABLE 1-5 shows a list of the parameters in the file
that you may need to change during initial installation. A listing of the entire
rmparams  file is provided in “rmparams File Listing” on page 60. Most of these
options (other than the ones shown in TABLE 1-5) should not be changed, and many
of the other options should only be changed through the GUI.

Note – You must edit the rmparams  file to increase LUN support per host adapter
or if you want to enable SNMP notification (see “SNMP Notification” on page 20).

1. For multiple LUN support, edit the /etc/raid/rmparams  file to increase the
parameter line System_MaxLunsPerHostAdapter  to:

■ 8 for Solaris 2.5.1

■ 32 for Solaris 2.6 (with patch installed)

Change the System_MaxLunsPerControllers  parameter from 8 to 32 if you are
running Solaris 2.6 and your system supports 32 LUNs per RAID Module.

This parameter determines the maximum number of logical units supported per
RAID Module. Remember that this limit applies to a RAID Module (whether it has a
single controller or redundant controllers). Therefore, if you have a RAID Module
with two active controllers, the total number of LUNs between them cannot be more
than 32.

2. Make any necessary changes for other parameters using TABLE 1-5.
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TABLE 1-5 Optional Changes for Additional Parameters

Parameter Description When To Change How To Change

System_MaxLunsPerHostAdapter=16 Determines the
maximum number of
logical LUNs
supported per host
adapter.

Note: This applies to
LUNs per host
adapter. There is still a
Solaris limit of eight
LUNs per RAID
Module.

If you have Solaris
2.5.1 installed.

Edit the rmparams
file and change “32”
to the appropriate
number.

System_MaxLunsPerControllers=8 Determines the
maximum number of
logical units per RAID
Module supported by
the storage
management
software, and also sets
the highest LUN
number displayed in
that software.

After determining if
you can support 32
LUNs.

Edit the rmparams
file and change the 8
to 32.

SNMP_Target_IP_Address=127.0.0.1 Provides the SNMP IP
Address for remote
notification.

If you want to
enable SNMP
notification.

See “SNMP
Notification” on
page 20.

SNMP_Community_Name=NONE Provides the
community name to be
used for SNMP remote
notification.

If you want to
enable SNMP
notification.

See “SNMP
Notification” on
page 20.

System_MaxControllers=32 Determines the
maximum number of
RAID Controllers
supported by RAID
Manager.

If you have more
than 32 RAID
controllers.

Edit the rmparams
file and change “32”
to the appropriate
number.

System_DefaultModuleSelect=FALSE Determines if the
Select Module box
displays each time you
open an application.

Anytime you want
to change the default
to display the Select
Module box so you
can select a specific
RAID Module after
you open an
application.

Edit the rmparams
file and change
FALSE to TRUE.
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Caution – You need to increase the System_MaxLunsPerControllers  parameter
if you are running Solaris 2.6 and can support more than eight LUNs on any RAID
Module, because this parameter also affects the highest LUN number that the RAID
Manager software displays. For example, if you have LUNs 0, 3, and 31 configured
on a RAID Module, LUN 31 would not appear in the display if this parameter were
only set to 8.

Note – Remember that this limit applies to a RAID Module (whether it has a single
controller or redundant controllers). Therefore, if you have a RAID Module with two
active controllers, the total number of LUNs between them cannot be more than 32.

3. Save the rmparams  file, then copy it to the /etc/default  directory.

4. Continue with “Setting Up Other Scriptable Notification Options.”

Setting Up Other Scriptable Notification Options
You can edit the rmscript  file. For example, if you want to install third-party
notification software to perform various events (such as, faxing or paging), you
would add the appropriate script for each event near the end of this file. Consult the
third-party’s software documentation for specific details.

For more information in this guide about the rmscript file, see:

■ “rmscript File Listing” section in Appendix A for the file’s contents.

■ The rmscript  man page for a description of the format this file uses.

Editing Example

The following procedure provides an example for editing the rmscript  file to add
two scripts for extracting information during a defined event and dispatching a
paging command.

Caution – The last line in the rmscript  file must always be rm $1 . Therefore,
when editing this file, always place any new event script above this line.
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1. To look for AEN events and create a command for a sendpage, add the following
event script near the end of the rmscript  file:

2. To look for parity errors and create a command for a sendpage, add the following
event script below the previously added text:

3. Do one of the following:

■ Continue with“SNMP Notification” if you are interested in using this remote
notification option.

■ If you do not want to enable SNMP at this time, go to “To Verify the
Installation” on page 13.

SNMP Notification
This software can provide remote notification of RAID events to designated network
management stations (NMS) using Simple Network Management Protocol (SNMP)
traps. Use the information in this section to set up the NMS, to enable or disable this
notification option for specific hosts, and to understand the contents of an SNMP
trap message.

You need to set up your designated NMS only once. Use the following procedure to
compile the RAID Manager Management Information Base (MIB) into your NMS.

# Use AWK to parse the common fields of the record.

eval ‘awk -F\~ ´NF > 0 {print ”TYPE=” $6 ”;HOST=” $1 ”;CONTROLLER=” $2 \
”;DATE=” $5 ”;TIME=” $6}´ < $1‘

# Simple test for AEN events. If one received, send a page to
# someone interested in any AEN event.
if [ $TYPE = ”00” ]
then sendpage ”John H. User” ”AEN event on $HOST”
fi

# Similar test, but for parity errors.
if [ $TYPE = ”20” ]
then sendpage ”John H. User” ”Parity errors found on ($HOST, $CONTROLLER)”
fi
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To enable SNMP notification on your host, you must edit the /etc/raid/
rmparams file so that the software will know where to direct the SNMP trap
messages when a RAID Event has occurred.

▼ To Set Up the NMS

Note – The MIB was written to standard version 1 SNMP syntax. It was designed
specifically for RAID Manager. It is not applicable to other vendor RAID products.

1. Copy the /etc/raid/rm6traps.mib  file to the network management station.

2. Follow the steps required by your specific network management station to
compile the MIB.

Note – For details on the required steps, consult your network administrator or the
documentation specific to the NMS product you are using.

▼ To Enable SNMP
1. Edit the /etc/raid/rmparams  file as follows:

a. Include the IP address of the host that has the SNMP-trap proxy agent. For
example:

b. Define the community name. For example:

2. Make sure the /etc/resolv.conf  file exists, even if it is empty.

3. Make sure that the /etc/raid/locks/rmparams.lock  file is writable by root.

This can be a problem if the RAID Manager software is NFS mounted.

SNMP_Target_IP_Address=129.146.243.54

SNMP_Community_Name=public
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4. Make sure that the /etc/raid/rm6traps.mib  file is compiled and imported by
the network management system.

For example, if you are using SunNet Manager, the command
mib2schema rm6traps.mib  creates the following files:

■ rm6traps.mib.schema

■ rm6traps.mib.oid

■ rm6traps.mib.traps

The rm6traps.mib.schema  and rm6traps.mib.oid  files are placed in the
/opt/SUNWconn/snm/agents  directory.

The rm6traps.mib.traps  file is appended to the
/var/opt/SUNWconn/snm/snmp.traps  file.

When an array event occurs, the script rmscript (1M) takes the information passed
by arraymon (1M) and constructs an SNMP trap message and then sends it to the
host defined in the /etc/raid/rmparams  file.

See your network management system documentation for more information on how
to install SNMP devices.

▼ To Disable SNMP
To disable this notification on your host and stop this software from sending SNMP
traps:

1. In the /etc/raid/rmparams  file,

■ Delete the SNMP_Target_IP_Address  line.
OR

■ Change the value of the SNMP_Community_Name line to NONE.

2. Save the rmparams  file. Then, copy it to the /etc/default  directory. It is critical
that you have a backup copy of this file.

SNMP Trap Message Description
TABLE 1-6 describes the contents of an SNMP trap message for RAID Manager.
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Note – If the trap type is anything other than informational, you should use the
Status or Recovery Applications to get more information or specific instructions on
how to remedy the problem. Do not remove the SNMP message until the problem
has been corrected, since most trap notifications associated with this software are not
persistent.

TABLE 1-6 SNMP Trap Message Description

Item Description

Host IP Address The standard IP address dot notation for the host where the RAID
Module is attached.

Host Name The text name assigned to the host.

Trap Type There are four trap types:
Informational – No failure has occurred. Information is provided
that an event such as a LUN creation has occurred.

Degraded Array – A subsystem component failure has occurred.
The module is still operational but now lacks redundancy in some
area. (For example, a drive failure resulting in a degraded LUN, a
power supply failure, or a failure of one controller in a controller
pair.)

Failed Array – A failure has occurred that leaves a module or LUN
unable to communicate. (For example, a failure of the controller in
a single-controller RAID Module or a multiple drive failure
resulting in a dead logical unit.)

Critical – This is a small category of failures that may require
timely intervention to correct. (For example, the two-minute
warning from an uninterruptible power supply or a warning that
write-back cache has been disabled due to a low battery.)

Affected RAID
Module

Indicates which RAID Module had the event (for example, RAID
Module 01).

Condition
Description

A string of characters (42 or less) describing the event that has
occurred.
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Software Limitations
TABLE 1-7 details the limitations of this software for operating with the Solaris
environment. You should also refer to Chapter 3, “Common Questions and
Troubleshooting” for troubleshooting information.

Note – Always check for a readme file on any installation media, or release notes
accompanying your documentation. These documents may contain important
information that was not available at the time this installation guide was prepared.

TABLE 1-7 Software Limitations and Suggested Workarounds

Restriction/Note Application Workaround

The RAID Module (subsystem) was
qualified on Solaris as a secondary
peripheral device only. No testing was
done to verify installation of the Solaris
operating system on the RAID Module
(that is, you cannot use the RAID Module
as a boot device).

General None

The status of a component after certain
configuration change operations may not
be updated immediately.

For example, this could occur after a
Manual Recovery task is completed,
especially LUN Reconstruction.

All Applications Wait for the background monitor to run
(default is five minutes) and update the
status.
OR
To update immediately, do one of the
following:

• Re-select the RAID Module.
• Exit and re-launch the application.

Using Recovery operations to revive or
fail an actual bad drive can cause the
RAID Controller to no longer be
reported. This also occurs when a failed
Hot Spare drive is replaced with a bad
drive. A series of time-outs in the RAID
Controller, RAID Manager, and the SCSI
host adapter driver eventually result in
the host stopping the retries. After this,
all SCSI operations to the controller fail
until the host is rebooted.

Recovery Reboot if a controller disappears after a
drive replacement or revival.

If a drive is suspect for some reason, it is
best to let the controller fail it during
normal I/O rather than trying to manually
fail it using Manual Recovery options.
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If you have both RAID Modules and
non-array devices (such as CD-ROM
drives, tape drives, or hard disks) on the
same physical bus, then the storage
management software see the modules
on a pseudo bus and their device names
do not match with Solaris.

General In order to have RDAC protection to these
modules, you must accept the pseudo
device name that appears.
If the modules are single-controller or
otherwise don't require RDAC protection,
edit the rmparams  file to change the
RDAC_SupportDisabled parameter to
TRUE. Then the device names for the
modules will match in this software and
Solaris.

When you replace a failed drive, this
software allows 35 seconds for the
controller to initialize the new drive.
However, if you have a 3620 controller
and are in a Dead LUN situation (single
Drive Failure for RAID 0 or Multiple
Drive Failure for RAID 1, 3, or 5),
Recovery Guru does not perform a
format on the LUNs. If you do not
manually format the LUNs, subsequent
file system mounts will fail.

Recovery,
Recovery Guru

After inserting the replacement drive, wait
for the drive’s activity light to go off
before clicking OK (that is, wait for more
than 35 seconds).

If you do not wait and you see the LUN is
still Dead due to remaining
drive failures message, you need to
use Options ➔ Manual Recovery ➔
Logical Units and Format the affected
LUNs.

If the affected LUNs had file systems that
failed to mount, use newfs  to create a new
file system.

Recovery Guru may display misleading
information for replacing or reviving a
failed single-drive RAID 0 LUN. Also, if
power to the RAID Module is turned off
and back on when this drive is failed,
the LUN is no longer visible and must
be recreated using the Configuration
Application.

Caution
Remember that if a drive fails in a RAID
0 LUN, data cannot be recovered from
that drive.

Recovery,
Recovery Guru

If you are using this configuration and a
drive failure occurs, do the following:

Physically replace the failed drive with a
good drive.
Select Options ➔ Manual Recovery ➔
Drives, highlight the failed drive (the
drive you just replaced), and select
Revive.
Ignore the error panel that displays.
Select Options ➔ Manual Recovery ➔
Logical Units, highlight the affected LUN,
and select Format.

The LUN’s status returns to Optimal when
the format is complete; however, you have
lost the data on that LUN.

TABLE 1-7 Software Limitations and Suggested Workarounds (Continued)

Restriction/Note Application Workaround
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The more configured LUNs you have
can increase the amount of time it takes
to change the reconstruction rate. This
occurs because of the update/refresh
functions involved in changing this rate.

Maintenance/
Tuning
LUN
Reconstruction
Rate

None. Continue changing the rate for as
many LUNs as possible between
appearances of the hourglass.

TABLE 1-7 Software Limitations and Suggested Workarounds (Continued)

Restriction/Note Application Workaround
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CHAPTER 2

Initial Startup

This chapter contains the following procedures that describe how to operate the
RAID Manager software properly and determine if the system configuration meets
your needs.

■ Starting the Software — page 28

■ Upgrading Controller Firmware — page 29

■ Running A Health Check — page 30

■ Determining the Current Configuration — page 33

■ Determining if Changes Are Necessary — page 38

■ What’s Next? — page 41
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Starting the Software

Note – You must have superuser privileges to access this software.

1. Start OpenWindows if it is not already running.

Note – You can add /usr/sbin/osa  to your path. After doing so, you will only
need to type rm6  to start RAID Manager.

2. Start RAID Manager by typing the following:

The application icons (FIGURE 2-1) are displayed and you are ready to select the
various applications. For a description of some key terms used in the RAID Manager
applications, see the RAID Manager User’s Guide.

FIGURE 2-1 Application Icons

/usr/sbin/osa/rm6
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Note – RAID Manager uses the iso8859 font/character set for its various displays. If
you do not have these fonts installed, RAID Manager will use the fonts that are
available, which could cause minor display problems. If you suspect this is
happening, verify that you have the correct Sun font packages installed by typing
pkginfo SUNWxwoft SUNWxwcft . If neither of these font packages exist, install
them.

Upgrading Controller Firmware
The controller firmware files were copied during installation to the /etc/raid/fw
directory, and will be detected by the Firmware Upgrade option in the
Maintenance/Tuning application.

To download controller firmware version 2.4.4 or later, follow the Upgrading
Controller Firmware procedure in the RAID Manager User’s Guide.

You need to edit the module information if any of your RAID Modules are using the
Independent Controller Configuration (that is, two host machines connected to a
dual-controller RAID Module). In this configuration, one host machine is connected
by a SCSI Bus to one controller, and a second host machine is connected by another
SCSI bus to the other controller. Edit the module information as follows:

1. Choose Select Module.

2. Highlight the module that has independent controllers, and click Edit.

3. Click the box next to Independent Controllers?  and click OK.

The main Select Module window is displayed, and the Indep. Cntrls?  column
now says Yes .

If you upgraded the storage management software from a previous version, your
RAID Module names have changed from RAID Module XX to <hostname_XXX>.
Choose Select Module ➔ Edit to change the module names.
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Running A Health Check
The Health Check application is used to immediately check selected RAID
Module(s) for failures on the I/O data path, controllers, drives, LUNs, and other
components. The software performs an immediate check of the selected RAID
Module(s) and displays a summary of the results.

▼ To Ensure That the RAID Modules Are
Operational

1. Double-click the Status icon from the application icon group.

The main Status screen is displayed (see FIGURE 2-2). The default screen shows All
RAID Modules and Message Log selected.

Note – RAID Manager assigns a number for each RAID Module connected to your
host system (for example, RAID Module 001, RAID Module 002 etc.) These
designations are shown at the top of each application’s screen.
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FIGURE 2-2 Main Status Screen
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2. Make sure that All RAID Modules is selected, then choose Health Check.

The display area shows the summary results of the health check on all of the RAID
Modules.

■ If all of the RAID Modules report an Optimal status, you are finished with this
procedure.

■ If any of the RAID Modules report a status other than Optimal, select that RAID
Module and click Show Details to determine the appropriate action to take.

FIGURE 2-3 Health Check Screen
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Determining the Current Configuration
Now that you have successfully installed the software, you need to use it to identify
each RAID Module connected to your host system and determine the module’s
current configuration (number of drives, number of controllers, LUNs, etc.).

Note – Most RAID Modules are preconfigured with LUNs already defined. This
LUN configuration may or may not work for your particular environment.

Note – RAID Manager assigns a number for each RAID Module connected to your
host system (for example, RAID Module 001, RAID Module 002, etc.). These
designations are shown in the RAID Module selection list near the top of each
application’s screen (see FIGURE 2-4).

▼ To Identify the Module and Determine Its
Current Configuration

1. View the current drive groups and LUNs in a RAID Module.

a. Double-click the Configuration icon from the program group.

The main Configuration screen is displayed (FIGURE 2-4). The configuration
information for RAID Module 001 is shown by default. The main Configuration
screen is composed of the following major areas:

■ Module Information Area — Enables you to select a RAID Module, identify
and locate it, and obtain profile information about the controllers, drives, and
LUNs.

■ Drive Groups Area — Provides an overview of the different drive groups and
their characteristics on the selected RAID Module.

■ Logical Unit (LUN) Information Area — Provides a summary of the LUNs
configured on the selected RAID Module.
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FIGURE 2-4 Main Configuration Screen

b. Make sure that the first RAID Module is selected in the RAID Module
selection list near the top of the main Configuration screen.

Note – If you have more than one RAID Module connected to your host system,
each RAID Module appears in the list.

c. At the main Configuration screen, view the current drive groups and LUNs.

As you highlight a drive group in the list on the left side of the main screen, the
corresponding LUNs are highlighted in the LUN Information area on the right
side of the screen. You can highlight only one drive group at a time. You cannot
select or highlight any item in the LUN information list (it is information only).

2. Locate and label a RAID Module.

a. Click Locate Module, then Start.

The activity lights flash on the drive canisters in this module. Remember that the
RAID Module is the entire unit and not a particular set of drives.
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b. Physically locate the RAID Module that has its activity lights flashing.

Once you have identified the RAID Module, place a sticker label on it (for
example, RAID Module 001, RAID Module 002, etc.) that corresponds to the
number of the RAID Module you selected in Step b of Step 1 above. Use the label
for future reference.

c. Click Stop to turn off the flashing activity lights.

Note – It is very important that you save the profile of each RAID Module during
initial installation and any time you change your configuration. You can use this
information as a reference if you need to perform any recovery or maintenance tasks.

3. Save and print a RAID Module’s profile information.

a. Make sure the desired RAID Module is selected.

b. From the top menu, choose File ➔ Save Module Profile.

A screen shows the different types of information you can save.

c. Make sure All is selected (all of the buttons should be selected), then click OK
to save all of the types of information.

A screen display prompts you for a file name.

d. Enter an appropriate path and file name on the Selection line, then click OK.

The information is saved to the path and file name you specified.

e. Print the Module Profile information you saved in Step d using your host
system's printer utility.
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4. (Optional) View a RAID Module’s profile.

a. Make sure the desired RAID Module is selected.

b. Click Module Profile.

A summary information screen displays (see FIGURE 2-5) information about the
controllers, drives, and LUNs in the RAID Module.

c. Click Controllers, Drives, or LUNs for more detailed information on these
components.

d. Click OK to exit the profile information.

5. (Optional) View details on specific drives in a drive group.

a. If you want to know which specific drives comprise a particular drive group,
select the drive group (in the main screen) and click List/Locate Drives.

b. Use the drive location information [x,y] provided in the list to physically locate
individual drives in the module.

You can also select Locate Module to flash the drives’ activity lights in the RAID
Module.

c. Click OK to exit the drive information.

6. Repeat Step 1 through Step 3 (and Step 4 and Step 5, if desired) for each RAID
Module connected to your host system.

You should now have enough information to understand what your current
configuration is for each RAID Module.
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FIGURE 2-5 Main Module Profile Screen
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Determining if Changes Are Necessary
In the previous section “Determining the Current Configuration” you should have
performed the following tasks for each RAID Module connected to your host
system:

■ Reviewed each module’s current configuration (controllers, drives, and LUNs/
drive groups).

■ Identified each RAID Module using Locate Module and labeled the module.

■ Saved the Module Profile information to a file using Save Module Profile, and
printed the information.

Now, determine if you need to make any changes to the configuration to meet the
requirements of your environment.

1. Use TABLE 2-1 and the Module Profile information you saved and printed to assist
you in determining if any changes are necessary.

2. If desired, exit the Configuration application.

TABLE 2-1 Determine Required Configuration Changes

Parameter Description Why Change? For More Information

GENERAL PARAMETERS

Controller
Mode

Maintenance/
Tuning

Applicable controller
modes are single
active, active/
passive, or active/
active.

If you have an
active/passive
controller pair, you
should consider
changing it to
active/active for
best performance.

See the Maintenance/
Tuning Application
chapter in the User’s
Guide.
Use the online help in
the Maintenance/
Tuning Application.

Auto Parity
Check/Repair

Maintenance/
Tuning ➔

Options

An automatic parity
check/repair process
runs each day at a
specific time.
Defaults are auto
parity enabled and
run at 2:00 am.

If you want to
disable the check/
repair or change the
time when it runs.
It is highly
recommended that
you do not disable
this feature.

See the Maintenance/
Tuning Application
chapter in the User’s
Guide.
Use the online help in
the Maintenance/
Tuning Application.
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Checking
Interval

Status➔

Options ➔ Log
Settings

The array monitor
checks the RAID
Modules periodically
looking for events
and failures.
The default is to
check every 5
minutes.

If you want to
increase or decrease
the frequency of the
checking interval.

See the Status
Application chapter in
the User’s Guide.
Use the online help in
the Status Application.

Hot Spare
Drives

Configuration
➔ Create Hot
Spare

A hot spare is a drive
containing no data
that acts as a standby
in case a drive fails in
a RAID 1, 3, or 5
LUN.
The hot spare adds
another level of
redundancy to your
RAID Module.

If you want to
create new or
additional hot spare
drives for added
protection.

See the Configuration
Application chapter in
the User’s Guide.
Use the online help in
the Configuration
Application.

LUN PARAMETERS

RAID Level or
Number of
Drives

Configuration
➔ Delete, then
Create LUN

Specifies how the
data is striped across
the drives and how
many drives
comprise a drive
group/LUN.

If the current RAID
Level is not
appropriate for
your environment,
or you need to
change the number
of drives.
Note: This requires
you to delete and
re-create the
LUN(s)/drive
group you want to
change.

See the Configuration
Application chapter in
the User’s Guide.
Use the online help in
the Configuration
Application.

Segment Size

Configuration
➔ Delete, then
Create LUN ➔

Options

Specifies in 512-byte
blocks how much
data is written to one
drive before data is
written to another
drive in the group.

If the segment size
is not appropriate
for your
environment.
Note: This requires
you to delete and
re-create the
LUN(s) you want to
change.

See the Configuration
Application chapter in
the User’s Guide.
Use the online help in
the Configuration
Application.

TABLE 2-1 Determine Required Configuration Changes

Parameter Description Why Change? For More Information
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Capacity

Configuration
➔ Delete, then
Create LUN ➔

Options

Specifies in Mbytes
how much capacity is
available on the
LUN(s).

If you want to
increase or decrease
the capacities.
Note: This requires
you to delete and
recreate the LUN(s)
you want to
change.

See the Configuration
Application chapter in
the User’s Guide.
Use the online help in
the Configuration
Application.

Caching

Maintenance/
Tuning

Specifies the caching
parameters for each
LUN.

If you want to
enable or disable
any of these
parameters.

See the Maintenance/
Tuning Application
chapter in the User’s
Guide to change
caching parameters on
existing LUNs, or use
the online help.
See the Configuration
Application chapter in
the User’s Guide if you
are creating new
LUNs, or use the
online help.

LUN
Assignment
and LUN
Balancing

Configuration
➔ Create LUN
➔ Options

Maintenance/
Tuning

Determines what
controller owns
which LUNs/
drive groups.

To reassign or
balance the LUNs/
drive groups
between controllers
in an active/active
pair.

See the Maintenance/
Tuning Application
chapter in the User’s
Guide to change LUN
Assignments on
existing LUNs, or use
the online help.
See the Configuration
Application chapter in
the User’s Guide if you
are creating new
LUNs, or use the
online help.

Reconstruction
Rate

Maintenance/
Tuning

Determines how
quickly
reconstruction
occurs on a LUN
when a failed drive is
replaced.

To increase or
decrease the
reconstruction
performance.

See the Maintenance/
Tuning Application
chapter in the User’s
Guide.
Use the online help in
the Maintenance/
Tuning Application.

TABLE 2-1 Determine Required Configuration Changes

Parameter Description Why Change? For More Information
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What’s Next?
Now that you have successfully completed the installation of the software, refer to
the RAID Manager User’s Guide for detailed information on how to use each
application and to make any changes that you determine are necessary.

Continue with Chapter 3, “Common Questions and Troubleshooting” for
troubleshooting tips on problems you may encounter as you use this software with
the Solaris operating environment.
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CHAPTER 3

Common Questions and
Troubleshooting

Common Questions
This chapter contains answers to common questions about using and
troubleshooting the RAID Manager software.

Note – If you cannot find the question you are looking for, consult the RAID
Manager User’s Guide for additional common questions that are independent of the
specific operating system.

TABLE 3-1 Common Questions About Using RAID Manager Software

How many logical units can I have per RAID Module?

Both the operating system and the host adapter limit the maximum number of LUNs they
can support. However, it may be possible to support up to 32 LUNs on a RAID Module.
Because this can involve several support changes, carefully follow the information and
procedures in “Configuring the Solaris Environment to Support RAID Manager” in
Chapter 1. These changes include installing patches for the version of Solaris you are using,
determining how many LUNs you can support (varies on the type of host adapter you
have), and changing certain parameters in the rmparams  file.
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How can I remove logical units from VERITAS control?

Important
If you are using VERITAS and you want to perform any RAID Manager operation that
requires exclusive access of the LUNs, you first need to remove the affected logical units/
drive groups from under VERITAS control, then unmount the devices. Such operations
include Delete for LUNs and Reset Configuration (Configuration), fixing Multiple Drive
Failures with Recovery Guru and formatting a LUN with Options ➔ Manual Recovery ➔

Logical Units (Recovery), and Firmware Upgrade ➔ Offline method (Maintenance/
Tuning).
1. Remove the LUN from its disk group by typing: vxdg [-g groupname] rmdisk diskname
For example, type: vxdg -g rootdg rmdisk disk01
2. Remove the LUN from Volume Manager control by typing: vxdisk rm devname
For example, type: vxdisk rm c1t0d0s2
3. Place the physical LUN offline by typing: vxdisk offline devname
For example, type: vxdisk offline c1t0d0s2

Are there special considerations when creating the LUNs/drive groups on a RAID Module?

If you are currently creating/formatting the first LUN and attempt to create another LUN on
a different drive group before the first LUN’s format is completed, the first LUN’s status
changes to Dead, then to Optimal after it is formatted. Subsequent LUNs on the different
drive group should be formatted successfully. However, subsequent LUNs on the same
(first) drive group could fail to be created.

This restriction applies to both the GUI and command line program raidutil .

Action:
Wait for the format to finish on the first drive group/LUN before creating LUNs on
additional drive groups.

TABLE 3-1 Common Questions About Using RAID Manager Software (Continued)
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What do I need to do after  creating a LUN?

Once you create a LUN using the Configuration Application, you have to make it part of the
operating system. Refer to your Solaris documentation for details on adding a drive.
Remember, each LUN (not a drive group) is seen by the operating system as one drive.

Can I disable the RDAC (redundant disk array controller) protection feature?

Yes. It is possible to disable the RDAC protection by adding the Rdac_SupportDisabled
parameter to the /etc/raid/rmparams  file and setting the value to TRUE. You also need
to reboot your system (boot -r ) for this change to take effect. See the rmparams  man page
for an explanation of this parameter.

Caution
If you do not have RDAC protection, certain features do not work as described in the User
Guide:
• Configuration — cannot check for I/Os before deleting LUNs. Therefore, make sure you
stop I/Os and no other users are on the system before selecting Delete LUN.
• Recovery and Status — Recovery Guru and Health Check may not display the Data Path
Failure type for every condition. Therefore, thoroughly verify that the interface cable/
terminator is not removed or damaged before proceeding with any controller-related
recovery procedure.
• Maintenance/Tuning — does not check for I/Os or verify LUNs are Optimal before
upgrading firmware, balancing LUNs, or changing controller mode:
1. Firmware Upgrade — the Online method for Firmware Upgrade is grayed out. Before

selecting the Offline method of Firmware Upgrade, you must stop I/Os and unmount
any file systems contained on the affected LUNs.

2. LUN Balancing/Controller Mode — make sure you stop I/Os because they could fail.
Also, if the LUNs contain file systems, you must first unmount them.

What files do I need for upgrading firmware?

You need to copy the appropriate controller firmware files to your host system.

Controller Firmware Files
When you receive new controller firmware files, copy them to your host system before
attempting to perform the upgrade procedure. With any new controller firmware upgrade,
you should receive one to three firmware files and the fwcompat.def  file. This last file
allows the software to compare the firmware files for compatibility during the upgrade
process, providing you with a list of compatible files to select for downloading. Also, the
software searches the default installation directory
/etc/raid/fw  for these files.

Important
If you do not copy fwcompat.def file to the host system, the software is unable to check
the files for compatibility. Although you can still enter firmware filenames and download
them, you do not have the protection that this compatibility check provides.

TABLE 3-1 Common Questions About Using RAID Manager Software (Continued)
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What environment variables do I need to update after installing the RAID Manager software?

After installing the RAID Manager software, you must include the following location in
your $PATH environment variable to enable command line access to the various tools and
utilities: /usr/sbin/osa

Are there any automation tools for building and configuring my Sun RSM Array 2000 system?

A set of configuration scripts has been included in this product to help you set up RAID
configurations. The scripts provide a “turnkey” setup mechanism based on several default
configurations, and they can also be used as templates for building your own custom
configurations. These scripts and an associated README can be found in the following
directory on the CD: /Tools/default_configs

Note
These scripts are designed specifically for use with Seagate ST15230W 4.2 Gbyte disk drives.
The scripts will need to be modified if other disk drives are used in the configuration.

Can I configure RSM Array 2000 devices during SunInstall?

It has been reported that some problems exist when attempting to configure RSM Array
2000 devices during SunInstall. Therefore, you should not configure RSM Array 2000
devices during SunInstall. Instead, wait until Solaris has completed installation on the host
system disks and until all required patches have been installed.

Is there Solaris AnswerBook™ support for the RSM Array 2000 product?

AnswerBook documentation on the RSM Array 2000 product is available on the CD in the
Product  subdirectory. Use this package only if you want access to online documentation
covering the RSM Array 2000—it is not required to run the software.

 If I remove the RSM Array 2000 controller module from my system, do I need to remove the software as
well?

If you remove the RSM Array 2000 controller module, you should also remove the RAID
Manager software to avoid any potential problems.

I have replaced a bad controller with a new one and upon bringing up the RAID Manager software, it
shows that the new controller is marked as passive . Is this expected behavior? How do I set the
controllers back to active/active  mode?

There are some conditions during administration of the RSM Array 2000 system using the
RAID Manager software that can cause controllers to set to active/passive mode. You can
reset the controllers to the active/active state as follows:

1. Go to the Maintenance and Tuning application of rm6 .
2. Select the RAID Module you want to change.
3. Select the Controller Mode icon.
The controller state will be listed.
4. Select the button to switch to Active/Active.
You will be prompted to balance the LUNs. Select this option if desired.

TABLE 3-1 Common Questions About Using RAID Manager Software (Continued)
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If my system experiences a failover and is running on one good controller, can I take the system down
to perform other system maintenance without replacing the bad controller?

The RSM Array 2000 system has been designed to recover from severe hardware failures. In
the case of a failed controller, the system will automatically move LUNs to the remaining
good controller. As long as the system is not rebooted, this failover process will ensure that
applications running on the system formerly using data from the failed controller can
continue to access the same data from the new controller using the old device name.

However, if you reboot the system using the boot -r  command after the failover has
occurred, device paths to LUNs previously located on the failed controller will change.
Many applications that are configured to look on a specific device may, therefore, stop
functioning.

In the case of a single controller failure, you should replace the failed controller as soon as
possible. Other system administration tasks that would normally require a boot -r,  such
as after adding a new SCSI device, should be deferred until the failed controller has been
replaced and brought back online, and all LUNs have been balanced back to the state in
which they existed when the failover occurred.

Is there any way to configure my system to not rename device paths during a boot -r  (reconfiguration
reboot)?

The way to ensure that device paths are preserved during reconfiguration reboots is to add
the string #!noauto_config  to the rdriver.conf  configuration file. Refer to the
rdriver(4)  man page for details.

Are there some things I can do from the RAID Manager graphical user interface (GUI) that I can't do from
the command line and vise versa?

Yes, Some functionality differences exist between the command line interface (CLI) utilities
provided with the RAID Manager software and the GUI facility. The functionality
differences are documented in TABLE 3-2 for reference only and are subject to change.
Where appropriate, the section under the GUI or the applicable CLI utility used to perform
the indicated function is included in the table.

TABLE 3-1 Common Questions About Using RAID Manager Software (Continued)



48 RAID Manager 6.1 Installation and Support Guide for Solaris • October 1997

TABLE 3-2 Functionality Differences Between the RAID Manager Graphical User
Interface and the Command Line Interface

Functionality GUI CLI

Display/modify/correct NVSRAM No Yes (nvutil )

Parity check and repair Yes — all, some or one LUN(s);
manual or automatic start
(Recovery Guru)

Yes — all or one LUN(s); manual
start only (parityck )

Create/delete LUN(s) Yes — all RAID levels; max 20
drives per LUN (Configuration)

Yes — all RAID levels; max 30
drives per LUN (raidutil )

Create/delete Global Hot Spare(s) Yes (Configuration) Yes (raidutil )

Set LUN reconstruction rate Yes (Maintenance/Tuning) Yes (raidutil )

Configure/enable/disable LUN
Read-Ahead Caching

No Yes (raidutil )

Enable/disable LUN write,
mirrored, nonvolatile caching

Yes (Maintenance/Tuning) Yes (raidutil )

Print Caching Mode Page No Yes (raidutil )

Report drive status and detailed
information (serial number, size,
firmware, etc.)

Yes (Module Profile) Yes (drivutil )

Report available space on a drive
group

Yes (Configuration) Yes (drivutil )

Report LUN status and detailed
information (size, RAID level,
number of pieces, etc.)

Yes (Module Profile) Yes — reports LUN RAID level
and size only
(raidutil,drivutil )

Report controller firmware version
and SCSI Inquiry information

Yes (Module Profile) Yes (raidutil )

Report controller device name,
serial number, owned LUNs

Yes (Module Profile) Yes (lad , rdacutil , raidutil )

Report controller status and mode Yes (Module Profile) Yes (rdacutil )

Load balancing Yes — even/odd load balancing;
LUN-by-LUN load balancing
(Maintenance/Tuning)

Yes — even/odd load balancing
(rdacutil )

Fail and unfail controllers Yes (Recover Guru) Yes (rdacutil )

Fail and unfail drives Yes (Recovery Guru) Yes (drivutil )

Controller mode switch Yes —
Active/Passive to Passive/Active,
Active/Passive to Active/Active
(Maintenance/Tuning)

Yes —-
Active/Passive to Passive/Active,
Active/Passive to Active/Active,
Active/Active to Active/Passive
(rdacutil )
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Locate RAID Module or drive
group

Yes (Configuration) No

Perform a Health Check on a RAID
Module

Yes (Status) Yes (healthck )

Report LUN reconstruction
progress

Yes (Status) No

Report RAID module events/
errors

Yes (Status) Yes (logutil )

Report detailed instructions for
recovering from component
failures

Yes (Recovery Guru) No

Manually start reconstruction on a
drive

Yes (Recovery Guru) No

Revive a drive or LUN Yes (Recovery Guru) Yes (drivutil )

Upgrade controller firmware Yes (Maintenance/Tuning) Yes (fwutil )

Functionality GUI CLI
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Troubleshooting: Solaris Solutions
The troubleshooting tables that follow provide probable cause and action to take for
specific problems you may have as you use the RAID Manager software with the
Solaris operating environment.

The first section includes general topics that you might encounter using any of the
applications. The sections that follow are organized by application.

Note – If you cannot find the problem you are looking for, consult the User’s Guide
for additional troubleshooting information. The User’s Guide troubleshooting is
independent of the specific operating system.

Note – Be sure to read “Software Limitations” on page 24 for the restrictions and
important notes for using this software in the Solaris environment.

■ General — page 51

■ Configuration Application — page 54

■ Status Application—Message Log — page 56

■ Recovery Application—Recovery Guru — page 57

■ Maintenance/Tuning Application—Firmware Upgrade — page 58
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General
In TABLE 3-3, you will find general problems you could have in all applications:

TABLE 3-3 General Troubleshooting

Software does not load when you type rm6 at the prompt.

Cause: The OpenWindows environment may not be running, or the rmparams  file may be
corrupted or missing from the installation (/etc/raid ) directory.

Action:
1. Start the OpenWindows environment and try to start the software again. (See “Starting the
Software” on page 28 if you need more information on starting this software.)

2. Copy the backup /etc/default/rmparams  file to the /etc/raid  directory and try to
start the software again.

Important
The rmparams file is required for normal operation of the RAID Manager utilities.
Therefore, if you make any changes to the /etc/raid/rmparams  file, copy the edited file
to the /etc/default  directory.

Font display problems on screen.

Cause: RAID Manager uses the iso8859 font/character set for its various displays. If you do
not have these fonts installed, then RAID Manager will use the fonts that are available
which could cause minor display problems.

Action: Verify that you have two Sun font packages installed:
1. At the system prompt, type: pkginfo SUNWxwoft SUNWxwcft .

2. If both packages do not exist, install them.

Some logical units are not visible on screen.

Cause: Any time a long operation is being performed (such as formatting LUNs, upgrading
controller firmware, checking/repairing parity, etc.) on logical units (LUNs), these LUNs do
not appear on the screen except in the application where the operation was initiated. The
software uses a file (/etc/raid/lunlocks)  to hide these LUNs from the other
applications, so that no other operations can be performed on them until the current
operation is completed. For example, if you started a format in the Recovery Application,
these LUNs show a “Formatting” status in Recovery, but do not appear in any other
application.

Should the utility holding the LUN lock come to an abnormal termination (that is, if it
crashes), these LUNs may remain hidden from the other applications.
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Action:
1. Wait for the operation to be completed, or perform operations on a different RAID
Module.
2. If the utility holding the LUN lock crashes and/or you do not see LUNs that you know
exist, do the following:
• Remove the lunlocks file (rm /etc/raid/lunlocks).
• Re-create this file (touch /etc/raid/lunlocks ).
• Exit, then re-enter the application that could not see the LUN.

Some controllers/RAID Modules are not visible on screen.

Cause: If controllers or RAID Modules are not displayed and you know they exist, there
could be some faulty connection between the RAID Module and the host adapter/network
card. It is also possible that the RAID software or operating system does not yet recognize
the devices. Less likely, the NVSRAM settings for the module’s controllers may not be set
properly to run this software. Normally, these settings are changed automatically during
installation, and any incorrect settings are detected and corrected by the software.

Action:
1. Verify there is no problem on the data path:
• Select Recovery Guru and follow the Fix procedures for any component problem
detected.
• Check the interface cables or network connections, as well as the SCSI IDs of the
controllers. If they appear OK, turn off power to the module, and turn it back on.
OR
2. If you see a message (on the console) that incorrect NVSRAM settings have been fixed,

immediately reboot the operating system (connected to your RAID Modules via SCSI
cable) so the new settings can take effect.

“Cannot secure access to the LUNs” message displays (operations won’t run for a selected RAID
Module).

Cause: Most likely a second application has requested exclusive access to the selected
RAID Module when some other application has already secured access.

Many operations require exclusive access to the affected drive group/LUNs until its
operation is completed (RAID Manager “locks” these components to secure this access).
Also, if the affected LUNs have mounted file systems or are under VERITAS control, RAID
Manager cannot gain exclusive access. Either this message is displayed, or the second
request is denied and an error message indicates that the module has I/Os occurring or file
systems are present. Operations requiring exclusive access include:

Delete for LUNs and Reset Configuration (Configuration); fixing Multiple Drive Failures
with Recovery Guru and formatting a LUN with Options ➔ Manual Recovery ➔ Logical
Units (Recovery); and Firmware Upgrade ➔ Offline method (Maintenance/Tuning).

TABLE 3-3 General Troubleshooting (Continued)
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Caution
If the RAID Module has a multi-host configuration, use caution when performing the tasks
that need exclusive access to ensure the two hosts do not send conflicting commands to the
controllers in the RAID Modules.

Action:
1. Wait for any RAID Manager operation that has secured exclusive access to the LUNs to

be completed before performing another operation on the same RAID Module.
2. If no other RAID Manager operations are running and the RAID Module has LUNs with

mounted file systems,
• Stop I/Os to the affected RAID Modules.
• Unmount the file systems on the RAID Module and select the operation again. If you are
unable to unmount the file systems (this may occur if writes were occurring when drives
failed), reboot your system.
• If you are using VERITAS, you need to remove the LUNs from VERITAS control. See
“How can I remove logical units from VERITAS control?” on page 44.

Solaris doesn’t use the new device name when LUN ownership is transferred between controllers
(Maintenance/Tuning ➔ LUN Balancing).

Although the device name will update in the application’s screen displays, Solaris continues
to use the original path (first controller’s device name) until you perform a reboot
(boot -r ) to recognize the configuration change.

 “Help files are missing or corrupted” message

Action: Check that the correct Help files are installed in the /etc/raid/bin/ directory.
You should have five help files: helpcfg.txt , helpstat.txt , helprecv.txt ,
helpmnt.txt , and glossary.txt . Re-install them if necessary.

TABLE 3-3 General Troubleshooting (Continued)
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Configuration Application

TABLE 3-4 Troubleshooting for Configuration Changes

Total capacity (main window) and available capacity (Create LUN screen) isn’t correct for a RAID Module
that has drives with different capacities.

If your unassigned drive group contains drives with different capacities, such as 9-GB and
4-GB, then Configuration initially bases the total capacity and available capacity of the
unassigned drive group (displayed in the Create LUN screen) on the capacity of the smaller
drives. For example, if the unassigned drive group consisted of three 9-GB drives and two
4-GB drives, then the total/available capacity shown would be 8 GB (4-GB x 2).

Furthermore, if you create LUNs using mixed capacity drives, you use only the smallest
capacity available (4-GB) and you cannot access the additional capacity on the larger drives.

Action: To avoid wasting the additional capacity of the larger capacity drives when
creating logical units, select drives of the same capacity:

1. Highlight the Unassigned drive group.
2. Select Create LUN and set the desired RAID Level, number of drives, and number of

LUNs.
3. Click Options ➔ Drive Selection and choose specific drives that share the same capacity

(large or small).

For example, if you were going to create a three-drive RAID 0 LUN and the unassigned drive
group contains 5 drives (two 2-GB drives and three 4-GB drives), you want to select the
larger capacity drives. Once you select the number of drives in the main Create LUN screen,
the available capacity is initially reported as 6-GB (instead of 12-GB). However, using
Options ‘ Drive Selection you can select the three 4-GB drives (move them to the Selected
Drives box) and the correct available capacity is reported.
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“The hot spare you just created at drive location [x,x] has a smaller capacity than some of the drives in
the module” message.

Cause: Hot spares cannot cover for drives with a larger capacity (that is, a 4 GB hot spare
drive cannot stand in for a 9 GB failed drive). If your unassigned drive group contains
drives with different capacities, then the Configuration Application selects the first available
drive, which may not be the largest capacity.

Note: Remember [x,y] indicates the unique location of the drive in the selected RAID
Module. This identifier corresponds to the drive’s SCSI Channel number and SCSI ID where
the channel number is always listed first. For example, [2,8] corresponds to the drive at
location SCSI Channel 2 and SCSI ID 8.

Important
The unassigned drive group must contain a drive of the largest capacity in order for you to
create a hot spare that can cover for any failed drive in the RAID Module.

1. Before creating hot spares, use List/Locate Drives to determine the sizes of the drives in
the RAID Module, and to record the capacities and location of the larger-capacity drives
in the unassigned drive group.

2. In the main Configuration screen, highlight the Unassigned drive group.
3. Select Create Hot Spare.
4. Select the number of hot spare drives you want to create, then select Options.
5. Does a larger-capacity drive appear in the Selected Drives list?
• YES. Select Create.
• NO. Highlight a larger-capacity drive in the Unselected Drives list. Select Move. Select
Create.

TABLE 3-4 Troubleshooting for Configuration Changes (Continued)
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Status Application—Message Log

TABLE 3-5 Troubleshooting for Message Log

Unexpected information in Message Log.

Cause: If you do not see the information you expect in Message Log, most likely your
default log file is new or has been cleared recently. It could also mean that there are no
messages for the message type you selected (from List Type), or for the RAID Module you
selected. Normally, no messages in the log indicates that no events have been detected, so
nothing has changed, gone wrong, or been corrected.

Note: It is possible to detect and correct problems using Health Check before the
background monitor detects them, especially if you change the checking interval to a time
larger than the default setting (five minutes). In such cases where you correct problems
before the background monitor detects them, these events are not written to Message Log.

Action: If you do not see any messages and feel that an empty log is not possible:

1. Select List Type to be sure that All message types are selected.
2. Try selecting another module or All RAID Modules.
3. Check Current Log File at the bottom of the screen to verify that it matches the log file

specified as the default in Log Settings. The default log is the file new messages are
written to.

4. From the top menu, choose File → Open Log to view a different log file.

If these do not work, try the following for your Solaris operating system:
a. Check the file permissions of the log file. Does root have read/write access to the file?
b. If the file does not exist, does root have read/write/execute access to the directory?
Execute access to a directory means the ability to get a directory listing.
c. Is the arraymon  daemon actually running? Type ps -ef | grep array to look for
the process.
d. Does the script /etc/raid/bin/rmscript  exist and have at least the
putplog $1  line?
e. Does root have read/execute privileges for the /etc/raid/bin/rmscript  file?
f. Does the executable /etc/raid/bin/putplog  exist and have execute privileges?
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Recovery Application—Recovery Guru

TABLE 3-6 Troubleshooting for Recovery Guru

Cannot secure access to the LUNs .

Cause: If you have multiple drive failures on a LUN/drive group, Recovery Guru needs
exclusive access to that LUN in order to provide instructions for replacing the failed drives
and restoring the LUN. If file systems are mounted on the affected LUN, Recovery Guru
does not have this access.

Note: This also can occur if a single drive fails in a module without RAID technology.

Action:
1. Wait for any RAID Manager operation that has secured exclusive access to the LUNs to

be completed before performing another operation on the same RAID Module.
2. If no other RAID Manager operations are running and the RAID Module has LUNs with

mounted file systems,
• Unmount the file systems on the RAID Module and select the operation again. If you are
unable to unmount the file systems (this may occur if writes were occurring when drives
failed), reboot your system.
• If you are using VERITAS, you need to remove the LUNs from VERITAS control. See
“How can I remove logical units from VERITAS control?” on page 44.
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Maintenance/Tuning Application—Firmware
Upgrade

TABLE 3-7 Troubleshooting for Maintenance/Tuning

Cannot secure access to LUNs (when upgrading controller firmware)

Cause: The software needs exclusive access to the LUNs in order to perform an Offline
firmware upgrade in the Maintenance/Tuning Application.

Action:
1. Wait for any RAID Manager operation that has secured exclusive access to the LUNs to

be completed before performing another operation on the same RAID Module.
2. If no other RAID Manager operations are running and the RAID Module has LUNs with

mounted file systems,
• Unmount the file systems on the RAID Module and select the operation again. If you are
unable to unmount the file systems (this may occur if writes were occurring when drives
failed), reboot your system.
• If you are using VERITAS, you need to remove the LUNs from VERITAS control. See
“How can I remove logical units from VERITAS control?” on page 44.

No firmware files/version(s) display.

Cause: If the area under Compatible Files/Version(s) is blank after you select Firmware
Upgrade, then the default directory does not contain all the necessary firmware files or the
fwcompat.def  file does not recognize the release version of your controller firmware.
Remember that the software first searches the default installation subdirectory
(/etc/raid/fw/ ) for the firmware files and the fwcompat.def  file. If you copy these files
to another directory, remember that it must also contain fwcompat.def , or you will see a
no compatible files found  message.

Action:
1. If you copied the files to some directory other than the default directory, enter that

directory on the Path line, then select OK. If you have copied these files to another
directory, remember that it must also contain fwcompat.def , or you will see a no
compatible files found  message.

2. Recopy the firmware files and the fwcompat.def  file to the fw  directory and try the
firmware upgrade process again.

Note: You should select the version line that has both Firmware Level and Boot Level
versions specified.

3. If the upgrade fails a second time, obtain a new copy of the firmware upgrade files.
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APPENDIX A

Reference Material

This appendix includes the following reference material:

■ NVRAM Settings — page 59

■ rmparams File Listing — page 60

■ rmscript File Listing — page 65

■ man pages — page 68

NVRAM Settings
During installation of the software, the nvutil  program (which is part of the
installation package) will automatically check and, if necessary, change any NVRAM
settings on the controllers in the RAID Modules necessary to run RAID Manager.
Thus, in most cases, you should have no concerns about NVRAM settings and will
need to read no further in this section.

However, if you have a RAID Module that has two controllers and you are not
seeing both controllers using the Module Profile  option in any of the applications
(such as Configuration or Status), or you are seeing unusual behavior, you may have
to change some NVRAM settings. You can use the command line nvutil  program
for this purpose. View the nvutil  man page for online usage instructions.

Note – If you make any changes with nvutil , reboot the system. If you do not
want to have to shut down your system, cycling power on the RAID Module
without a reboot is sufficient unless you have changed the values at offset 0x0011 or
0x0024.



60 RAID Manager 6.1 Installation and Support Guide for Solaris • October 1997

rmparams  File Listing
The following is a complete listing of the rmparams  file. Note that some values/
entries may not be the same as the file on your system.

Note – The rmparams  man page documents the parameters that are considered safe
for users to modify. All other parameters should be left alone.

Caution – Because of the critical nature of the rmparams  file, a backup copy of the
file has been installed in the /etc/raid/  directory. If the rmparams  file becomes
corrupted or missing, copy the /etc/raid/rmparams  file to the /etc/raid
directory to resume normal operation. If you make any changes to this file directly
or use the options in the GUI that write to this file (such as log settings, auto parity
settings, etc.), always copy the new version of the file to the /etc/raid  directory.

#******************************************************

#*** IDENTIFICATION ***

#******************************************************

#

# Name: rmparams

# Summary: RAID Manager Parameters File

# Component: solsysd

# Version: 8

# Update Date:%

# Programmer: %

#

# COPYRIGHT 1996, 1997 by Symbios Logic Inc.

#

# Description:
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# The RAID Manager Parameters File holds runtime parameters for
RAID Manager. RAID Manager programs access these values via the
GetParam and PutParam interfaces (params.c). This scheme
provides some control over RAID Manager behavior without use of
command line options or program recompilation.

#

# Reference:

# 1. PIP0003A.DOC, Source Code Integrity Measures

#

#Coding Standard Waivers:

#******************************************************

# System Parameters

System_AltDevDirRoot=/dev/symsm/dev/rdsk

System_LunlocksDirPath=/etc/symsm/lunlocks

System_MaxLunsPerController=8

System_MaxControllers=32

System_NamefileDirPath=/etc/symsm/mnf

System_RmHomeDirectory=/usr/lib/symsm

System_NametempDirPath=/etc/symsm/nametmp

System_TimestampDirPath=/etc/symsm/timestamps

System_RmBootHomeDirectory=/usr/lib/symsm/bin

System_RmFirmwareDirectory=fw

System_MaxHostAdapters=32

System_MaxSCSIid=31

System_MaxLunsPerHostAdapter=16

System_SafePassThroughLun=0

System_LunReDistribution=TRUE

System_NvsramDefDirPath=/usr/lib/symsm/fw/
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System_RdacBlkDirectory=/dev/symsm/dev/dsk

System_RdacChrDirectory=/dev/symsm/dev/rdsk

System_UnprotectedOfflineUpgradeAllowed=FALSE

System_DefaultModuleSelect=FALSE

# Array Monitor Parameters

Monitor_PollInterval=5

Monitor_ParityTime=02:00

Monitor_PchkEnabled=1

Monitor_ParityName=bin/parityck -aqf

# Graphical Viewer Parameters

Viewer_Log_Opened = rmlog.log

Viewer_Controller= All DiskArrays

Viewer_Select1= NONE

Viewer_Inequallity1= NONE

Viewer_Conjunction1= NONE

Viewer_Phrase1= NONE (NOTE: This value could be set to NONE or
it could appear blank)

Viewer_Select2= NONE

Viewer_Inequallity2= NONE

Viewer_Conjunction2= NONE

Viewer_Phrase2= NONE (NOTE: This value could be set to NONE or
it could appear blank)

Viewer_LogSize= 40

Help_Files_Directory = help/
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Help_Files_GlossaryName = help/glossary.txt

# Parity Assurance Parameters

# Limits for Parity_Amount is 1000 to 37767

# Limits for Parity_Delay is 0 to 10

Parity_Amount=10000

Parity_Delay=1

# Notification Parameters

Notify_LogName=rmlog.log

Notify_LogEnabled=1

Notify_ScriptName=usr/lib/symsm/bin/rmscript

# The System_CatalogLanguage parameter corresponds to

# the set ID in the RAID Manager message catalog.

# Supporting a new language involves adding a new set to

# the messages.cat file and setting the

# System_CatalogLanguage parameter to the new set ID. The

# currently defined sets are:

#

#        Set ID           Language

# ______ ________

#

#          101             ENGLISH

#
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# RAID Manager reserves sets 101 and above for its use; sets 1-
100 are available for user customization.

System_CatalogLanguage=101

# RDAC driver/Resolution Daemon Failover parameters

Rdac_SupportDisabled=FALSE

Rdac_Forced_Quiescence_Flag=TRUE

Rdac_Fail_Flag=TRUE

Rdac_Quiescence_Timeout=5

Rdac_Ioctl_Retry_Flag=TRUE

#SNMP Trap Notification Daemon Definitions

#SNMP_Action_Number=0 - no notifications are sent

#SNMP_Action_Number=1 - SNMP version one traps are sent

#SNMP_Action_Number=2 - all relevant data is written to the
file trap.dat

SNMP_Target_IP_Address=127.0.0.1

SNMP_Community_Name=NONE

SNMP_Action_Number=0
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rmscript  File Listing
The following is a complete listing of the rmscript  file. Note that some values/
entries may not be the same as the file on your system.

Caution – The last line in the rmscript  file must always be rm $1 .

#!/bin/sh

#######################################################

### IDENTIFICATION###

########################################################

# Name: rmscript

# Title: Initial RAID Manager event notification script

# for Solaris

# Version:

# Revision:

# Update Date:

# Programmer:

# Documents:

#

# COPYRIGHT 1995 SYMBIOS LOGIC

#

# Description:

# This script is called by the RAID Manager application

# or daemon every time a new event has been detected.

# The application creates an event record and saves it
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# in a file whose name is passed as the first argument

# to this script.

#

# After initial installation, users may change this

# script to add or remove features, such as mailing

# the superuser account, etc. However, this script

# should always call putplog to update the proprietary

# log (disabling of this can be done via the parameter

# file), and it must delete the event file when it is

# done with it.

#

# Add the event to the proprietary log

putplog $1

# Add the event to the syslog

EVTYPE=‘cut -d\~ -f6 $1‘

if [ EVTYPE != 30 ]

then

(case $EVTYPE in

# An AEN event

00) awk -F\~ 'NF > 0 { printf “AEN event Host=%s Ctrl=%s
Dev=%s\n

ASC=%s ASCQ=%s FRU=%s LUN=%s LUN Stat=%s\n Sense=%s”, $1, $2,
$3, substr($7,1,2), substr($7,3,2), $8, $9, $10, $11 }' < $1;;

#

#Mode Page events are ignored for now

#10) ;;
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#

#Parity event

20) awk -F\~ 'NF > 0 { printf “Parity event Host=%s Ctrl=%s
Dev=%s\n

Start Blk=%s End Blk=%s # Blks=%s LUN=%s “, $1, $2, $3, $7, $8,
$9, $10 }' < $1;;

#

#Text events are ignored for now

90) ;;

esac) | ( if [ -x “/usr/ucb/logger” ]

  then

      /usr/ucb/logger -t raid -p user.err

          elif [ -x “/usr/bin/logger” ]

  then

      /usr/bin/logger -t raid -p user.err

  fi

  )

# Mail the superuser that an event has occurred

(awk -F\~ 'NF > 0 { printf “An array event has been detected on
Controller %s \n  Device %s at Host %s - Time %s %s\n”, $2, $3,
$1, $4, $5 }' < $1;

 echo “\nGo to the Message Log in the Status Application for
details” ) | mailx -s “raid Event” root

case $EVTYPE in

   00) cCode=”‘cut -d\~ -f7 $1‘”

       cCode=”‘echo 0000$cCode‘”;;

   20)cCode=”‘cut -d\~ -f11 $1‘”;;

   90)cCode=”‘cut -d\~ -f11 $1‘”;;
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esac

ctrlName=”‘cut -d\~ -f2 $1‘”

hostName=”‘cut -d \~ -f1 $1‘”

hostIP=”‘nslookup $hostName | sed -n '5,5p' | cut -d : -f2‘”

trapcntl $cCode $ctrlName $hostIP $hostName

fi

# Delete the event file (needed since arraymon does not do
this)

rm $1

man pages
The following man pages provide supplementary information for disk array
management and administration.

■ arraymon

■ lad

■ logutil

■ nvutil

■ parityck

■ raidman

■ raidutil

■ rdac

■ rdacutil

■ rdaemon

■ rmevent

■ rmparams

■ rmscript

■ storutil
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Some tasks are carried out automatically by daemon processes that run from system
startup to system shutdown. There are, however, command line utilities that enable
you to embed customized and/or interactive operations.

For an overview of the RAID Manager graphical user interface, command line
programs, daemon programs, driver modules, and customizable elements, see the
raidman  man page.
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Index

C
cannot secure access to LUNs message, 57, 58
capacity

mixed drive sizes, 54
changes to support RAID Manager, 15
checking hardware and software, 2
checking module status, 30
components required, 2
configuration

determining current setup, 33
RAID Modules, 33

Configuration Application
main screen illustrated, 34
starting, 33
troubleshooting, 54

controllers
not visible on screen, 52

D
determining configuration

current setup, 33
when to change, 38

device name
LUN ownership and, 53

disabling RDAC, 45
drives

mixed capacity restrictions, 54

E
error messages

see messages

F
files

firmware, 45
fwcompat.def, 45
lunlocks, 51
rmparams

listing, 60
see also man pages
see also rmparams

filesystems
unmounting, 53, 57, 58

Firmware Upgrade
blank screen, 58
files needed, 45

fonts required, 29, 51
fwcompat.def file, 45, 58

H
hardware requirements, 2
Health Check

main screen illustrated, 32
running, 30

host adapter
LUN limit per, 16, 18
required hardware, 2
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hot spare
described, 39
too small capacity, 55

I
identifying module configuration, 33
installation

before beginning, 2
verification, 13

L
log file, empty, 56
logical units

cannot secure access message, 57, 58
limit per host adapter, 16, 18
limit per module, 16, 18
not visible on screen, 51
removing from Veritas control, 52

lunlocks file, 51

M
Maintenance/Tuning Application

troubleshooting, 58
man pages

overview, 68
Message Log

troubleshooting, 56
unexpected information, 56

messages
cannot secure access to LUNs, 57, 58
help files missing or corrupted, 53
non-optimal Health Check results, 30

MIB file, 21
Module Profile

main screen illustrated, 37
multi-host, 2
multi-initiator, 2

N
NMS

see SNMP
notification

see rmscript
see SNMP

NVRAM settings, 59
NVSRAM

settings, 52
nvutil

see also NVRAM settings

O
online help

can’t access, 53

P
pkgadd

installing update software, 8
preparing to install, 2
program group

illustrated, 28

R
RAID Module

checking status, 30
identifying configuration, 33
LUN limit per, 16, 18
not visible on screen, 52

RDAC
disabling, 45

RDAC (not supported), 45
Recovery Guru

restrictions, 57
troubleshooting, 57

restrictions
cannot secure access to LUNs, 57, 58
LUN limits, 16, 18
mixed capacity drives, 54
software and operating system, 24

rmparams
file contents, 60
missing, 51
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rmscript
scriptable notification, 19

S
screen illustrations

Configuration Application, 34
Health Check, 32
Module Profile, 37
program group, 28
Status Application, 31

settings, NVRAM, 59
simple network management protocol

see SNMP
SNMP

disabling, 22
enabling, 21
MIB file and, 21
set up NMS, 21

software
doesn’t start, 51
installing, 4
program group

illustrated, 28
requirements, 2
restrictions, 24
starting, 28
support changes, 15

Solaris
installing with, 4
LUN limits, 16, 18
requirements, 2
restrictions with RAID Manager, 24
troubleshooting, 50

starting
Configuration Application, 33
RAID Manager, 28

Status Application
main screen illustrated, 31
troubleshooting

Message Log, 56
status, checking modules, 30

T
troubleshooting

Configuration Application, 54
Firmware Upgrade, 58
general for all applications, 51
hot spare creation, 55
Message Log, 56
mixed capacity drives, 54
Recovery Guru, 57
removing LUNs from Veritas control, 52
Solaris, 50

U
unmounting filesystems, 53, 57, 58
upgrading controller firmware

no files/version displayed, 58
restrictions, 58

User Guide, when to use, 41

V
verifying installation, 13
Veritas

removing LUNs from its control, 52
version, determining for Solaris, 2
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